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Driver for TCP/IP Communication with GE FANUC Devices  
Using the Service Request Transfer Protocol (SRTP) 
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Introduction 

The SRTP driver enables TCP/IP communication between the Studio system and GE FANUC devices using the 
Service Request Transfer Protocol (SRTP), according to the specifications discussed in this document.  

This document will help you to select, configure and execute the SRTP driver, and it is organized as follows: 

 Introduction: This section, which provides an overview of the document. 

 General Information: Identifies all of the hardware and software components required to implement 
communication between the Studio system and the target device.  

 Selecting the Driver: Explains how to select the SRTP driver in the Studio system. 

 Configuring the Device: Describes how the target device must be configured to receive communication from 
the SRTP driver. 

 Configuring the Driver: Explains how to configure the SRTP driver in the Studio system, including how to 
associate database tags with device registers. 

 Executing the Driver: Explains how to execute the SRTP driver during application runtime. 

 Troubleshooting: Lists the most common errors for this driver, their probable causes, and basic procedures 
to resolve them. 

 Sample Application: Explains how to use a sample application to test the SRTP driver configuration 

 Revision History: Provides a log of all changes made to the driver and this documentation. 

 

 Notes: 
 This document assumes that you have read the “Development Environment” chapter in Studio’s Technical 

Reference Manual. 

 This document also assumes that you are familiar with the Microsoft Windows NT/2000/XP environment. If 
you are not familiar with Windows, then we suggest using the Help feature (available from the Windows 
desktop Start menu) as you work through this guide.  
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General Information 

This chapter identifies all of the hardware and software components required to implement TCP/IP 
communication between the SRTP driver in Studio and a GE FANUC device using SRTP.  

The information is organized into the following sections: 

 Device Specifications 

 Network Specifications 

 Driver Characteristics 

 Conformance Testing 

Device Specifications 

To establish communication, your target device must meet the following specifications: 

 Manufacturer: GE FANUC 

 Compatible Equipment: Series 90 PLC 

 Programmer Software: LogicMaster 90 Programmer Controller Software 

For a description of the device(s) used to test driver conformance, see “Conformance Testing” on the next page. 

Network Specifications 

To establish communication, your device network must meet the following specifications: 

 Device Communication Port: SRTP port 

 Physical Protocol: Ethernet 

 Logic Protocol: Service Request Transfer Protocol (SRTP) 

 Device Runtime Software: None 

 Specific PC Board: Ethernet 

 Link Cable Scheme: Ethernet 

Driver Characteristics 

The SRTP driver package consists of the following files, which are automatically installed in the /DRV 

subdirectory of Studio: 

 SRTP.INI: Internal driver file. You must not modify this file. 

 SRTP.MSG: Internal driver file containing error messages for each error code. You must not modify this 

file.  
 SRTP.PDF: This document, which provides detailed information about the SRTP driver. 

 SRTP.DLL: Compiled driver. 

 

 Note: 

You must use Adobe Acrobat® Reader™ to view the SRTP.PDF document. You can install Acrobat Reader 

from the Studio installation CD, or you can download it from Adobe’s Web site.  

 

You can use the SRTP driver on the following operating systems:  

 Windows NT/2000/XP 

 Windows CE  

For a description of the operating systems used to test driver conformance, see “Conformance Testing” 

below. 
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The SRTP driver supports the following registers: 
 

Register Type Length Write Read Bit Integer Float BCD 

%I (Discrete Input) 1 Bit      

%Q (Discrete Output) 1 Bit      

%M (Discrete Internal) 1 Bit      

%T (Discrete Temporary) 1 Bit      

%AI (Analog Input) 2 Bytes      

%AQ (Analog Output) 2 Bytes      

%R (Internal Registers) 2 Bytes      

%G (Global Genius Data) 1 Bit      
 
 

 Attention: 

 You can read bit values from %AI, %AQ and %R registers, but you cannot write bit values to these registers. 

 

Conformance Testing 

The following hardware/software was used for conformance testing: 

 Equipment: PLC GE FANUC 90/30 CPU 350 with CMM 321 Ethernet Interface 

 Cable: Ethernet cable 

 Operating System (development): Windows XP with Service Pack 2  

 Operating System (target):  

– Windows XP with Service Pack 2 

– Windows CE v4.0 

 Studio Version: 6.1 

 Driver Version: 1.05 
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Selecting the Driver 

When you install Studio, all of the communication drivers are automatically installed in the \DRV subdirectory but 

they remain dormant until manually selected for specific applications. To select the SRTP driver for your Studio 
application: 

1. From the main menu bar, select Insert Driver to open the Communication Drivers dialog.  

2. Select the SRTP driver from the Available Drivers list, and then click the Select button.  

 

Communication Drivers Dialog 

3. When the SRTP driver is displayed in the Selected Drivers list, click the OK button to close the dialog. The 
driver is added to the Drivers folder, in the Comm tab of the Workspace. 

 

 Note: 

It is not necessary to install any other software on your computer to enable communication between Studio 
and your target device. However, this communication can only be used by the Studio application; it cannot 
be used to download control logic to the device. 

To download control logic to a GE FANUC device, you must also install the GE FANUC programming 
software (e.g., LogicMaster 90). For more information, please consult the documentation provided by the 
device manufacturer. 

 
 

 Attention: 
For safety reasons, you must take special precautions when installing any physical hardware. Please 
consult the manufacturer’s documentation for specific instructions. 
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Configuring the Device 

To configure the target device for communication, you only need to set its IP Address using the programming 
software (e.g., LogicMaster 90). 

Configuring the Driver  

Once you have selected the SRTP driver in Studio, you must properly configure it to communicate with your 
target device. First, you must set the driver’s communication settings to match the parameters set on the device. 
Then, you must build driver worksheets to associate database tags in your Studio application with the appropriate 
addresses (registers) on the device. 

Configuring the Communication Settings 

The communication settings are described in detail in the “Communication” chapter of the Studio Technical 
Reference Manual, and the same general procedures are used for all drivers. Please review those procedures 
before continuing. 

Because the SRTP driver communicates via Ethernet, using the host PC’s standard Network settings, no 
additional configuration of the driver’s communication settings is required. However, you may still review 
the settings by accessing the Communication Parameters dialog: 

1. In the Workspace pane, select the Comm tab and then expand the Drivers folder. The SRTP driver is 
listed here as a subfolder. 

2. Right-click on the SRTP subfolder and then select the Settings option from the pop-up menu. The SRTP: 
Communication Parameters dialog is displayed: 

   

 Select Settings from the Pop-Up Menu SRTP: Communication Parameters Dialog 

 

3. In the Communication Settings dialog, configure the driver settings to enable communication with your 
target device. To ensure error-free communication, the driver settings must exactly match the 
corresponding settings on the device. Please consult the manufacturer’s documentation for instructions 
how to configure the device and for complete descriptions of the settings. 

Depending on your circumstances, you may need to configure the driver before you have configured your 
target device. If this is the case, then take note of the driver settings and have them ready when you later 
configure the device. 
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Attention: 

For safety reasons, you must take special precautions when connecting and configuring new 

equipment. Please consult the manufacturer’s documentation for specific instructions. 

 

The communication settings and their possible values are described in the following table: 

 

Parameters Default Value Valid Values Description 

Block Size 256 50 to  

(Rx Buffer / 2) 

Maximum number of bytes per message to be sent to the PLC. 
 
NOTE: Rx Buffer value is found in the Advanced Settings dialog 
(see more information below). 

 
 

 Note: 

If the value of Block Size is 0 (zero) , its value will be half of the value of the Rx Buffer setting (Default). 

The minimum valid value of Block Size is 50 bytes because it is the minimum number of registers that 

can be addressed at one time for certain register types. For more information, see page 12. 

The maximum valid value of Block Size is equal to half of the value of the Rx Buffer setting, which is 

found in the Advanced Settings dialog (see below). 

 

4. Click the Advanced button to open the Advanced Settings dialog: 

 

Advanced Settings Dialog 

Configure the parameters on this dialog as appropriate for your worksite. Consult the Studio Technical 
Reference Manual for instructions about configuring this dialog.  

5. Click OK to close the Advanced Settings dialog, and then click OK to close the Communication Settings dialog. 
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Configuring the Driver Worksheets 

Each selected driver includes a Main Driver Sheet and one or more Standard Driver Worksheets. The Main Driver 
Sheet is used to define tag/register associations and driver parameters that are in effect at all times, regardless of 
application behavior. In contrast, Standard Driver Worksheets can be inserted to define additional tag/register 
associations that are triggered by specific application behaviors. 

The configuration of these worksheets is described in detail in the “Communication” chapter of the Studio 
Technical Reference Manual, and the same general procedures are used for all drivers. Please review those 
procedures before continuing. 

For the purposes of this document, only SRTP driver-specific parameters and procedures are discussed here. 

MAIN DRIVER SHEET 

When you select the SRTP driver and add it to your application, Studio automatically inserts the Main Driver 
Sheet in the SRTP driver subfolder. To configure the Main Driver Sheet: 

1. Select the Comm tab in the Workspace pane. 

2. Open the Drivers folder, and then open the SRTP subfolder: 

 

Main Driver Sheet in the SRTP Subfolder 

3. Double-click on the MAIN DRIVER SHEET icon to open the following worksheet: 

                                  

Opening the Main Driver Sheet 

Header 

Body 
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Most of the fields on this sheet are standard for all drivers; see the “Communication” chapter of the 
Technical Reference Manual for more information on configuring these fields. However, the Station and I/O 
Address fields use syntax that is specific to the SRTP driver. 

4. For each table row (i.e., each tag/register association), configure the Station and I/O Address fields as 
follows: 

 Station field: Specify the IP Address of the target device, using the following syntax: 

<IP Address> 

Example — 192.168.0.200 

Where <IP Address> is the device’s IP Address on the Ethernet TCP/IP network. 

 I/O Address: Specify the address of the associated device register. 

For Discrete Input, Discrete Output, Discrete Internal, Discrete Temporary and Global Genius Data 

types, use the following syntax: 

<Register Type>:<Address> 

Example — %R:100 

For Analog Input, Analog Output and Internal Register types, use the following syntax: 

<Register Type>:[Data Type]<Address>.[Bit] 

 Example — %R:10.2 

Where: 

– <Register Type> : GE FANUC register type. Valid values are %I (Discrete Input), %Q (Discrete 

Output), %M (Discrete Internal), %T (Discrete Temporary), %AI (Analog Input), %AQ (Analog 

Output), %R (Internal Register), and %G (Global Genius Data). 

– [Data Type] (optional): Type of analog data. Valid values are DW (Double Word) , F (Float) and 

BCD (BCD). Although this parameter is optional, if no type is specified then it is Word by default. 

– <Address> : Address of the device register. This value must be within the valid range for the 

specified <Register Type>, according to the following table: 

 

Register Type Valid Range of Address Comments 

%I 1 to 512 Discrete Input 

%Q 1 to 512 Discrete Output 

%M 1 to 1024 Discrete Internal 

%T 1 to 256 Discrete Temporary 

%AI 1 to 1024 Analog Input 

%AQ 1 to 256 Analog Output 

%R 1 to 9999 Internal Registers 

%G 1 to 1280 Global Genius Data (Boolean) 
 

– [Bit] (optional): The bit number (from 0 to 15) of the address. 
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STANDARD DRIVER WORKSHEET 

When you select the SRTP driver and add it to your application, it has only a Main Driver Sheet by default (see 
previous section). However, you may insert additional Standard Driver Worksheets to define tag/register 
associations that are triggered by specific application behaviors. Doing this will optimize communication and 
improve system performance by ensuring that tags/registers are scanned only when necessary – that is, only 
when the application is performing an action that requires reading or writing to those specific tags/registers. 

 

 Note: 

We recommend configuring device registers in sequential blocks in order to maximize performance. 

 

To insert a new Standard Driver Worksheet: 

1. In the Comm tab, open the Drivers folder and locate the SRTP subfolder. 

2. Right-click on the SRTP subfolder, and then select Insert from the pop-up menu: 

 

Inserting a New Worksheet 

A new driver worksheet is inserted into the SRTP subfolder, and the worksheet is opened for configuring: 

   

SRTP driver Worksheet 

Most of the fields on this worksheet are standard for all drivers; see the “Communication” chapter of the 
Technical Reference Manual for more information on configuring these fields. However, the Station, 
Header, and Address fields use syntax that is specific to the SRTP driver. 

Header 

Body 
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3. Configure the Station and Header fields as follows: 

 Station field: Specify the IP Address of the target device, using the following syntax: 

<IP Address> 

Example — 192.168.0.200 

Where <IP Address> is the device’s IP Address on the Ethernet TCP/IP network. 

 Header field: Specify a single register type on the target device. The addresses declared in the Body of 
the worksheet will automatically be of this type. When Read/Write operations are executed for the 
entire worksheet (see Read Trigger and Write Trigger above), it scans the entire block of registers from 
the first address to the last. 

The Header field uses the following syntax: 

<Register Type> 

Example — %R 

Where <Register Type> is the GE FANUC register type. Valid values are %I (Discrete Input), %Q 

(Discrete Output), %M (Discrete Internal), %T (Discrete Temporary), %AI (Analog Input), %AQ (Analog 

Output), %R (Internal Register), and %G (Global Genius Data). 

After you edit the Header field, Studio checks the syntax to determine if it is valid. If the syntax is 
invalid, then Studio automatically inserts a default value of %I. 

You can also specify an indirect tag (e.g. {header}), but the tag that is referenced must follow the 

same syntax and contain a valid value. 

4. For each table row (i.e., each tag/register association), configure the Address field using the following 
syntax… 

For Discrete Input, Discrete Output, Discrete Internal, Discrete Temporary and Global Genius Data types, 
use the following syntax: 

<Address> 

Example — 100 

For Analog Input, Analog Output and Internal Register types, use the following syntax: 

[Data Type]<Address>.[Bit] 

Example — 10.2 

Where: 

– [Data Type] (optional): Type of analog data. Valid values are DW (Double Word),  F (Float) and BCD 

(BCD). Although this parameter is optional, if no type is specified then it is Word by default. 

– <Address> : Address of the device register. 

– [Bit] (optional): The bit number (from 0 to 15) of the address. 
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For examples of how device registers are specified using Header and Address, see the following table: 

 

Address on the Device  Header Field Address Field 

%I0001 %I 1 

%I0010 %I 10 

%I0512 %I 512 

%Q0512 %Q 512 

%M1020 %M 1020 

%T200 %T 200 

%AI060 %AI 60 

%AI060 (bit 0) %AI 60.0 

%AQ080 %AQ 80 

%AQ080 (bit 3) %AQ 80.3 

%R0100 %R 100 

%R0100 (bit 7) %R 100.7 

%R09900 %R 9900 

%G0500 %G 500 

%G0001 %G 1 

%I0001 %I 1 

%I0010 %I 10 

 

The SRTP driver is limited in that it will always request at least 5 bytes on the PLC for register types %AI, %AQ 
and %R, even when you try to read only a single register. This requires special precautions when addressing 
registers close to the limits of these register types.  

 

The same happens with register types %I, %Q, %M, %T and %G — the SRTP driver will always request at least 
50 bytes on the PLC even when you are trying to read only a single register. Therefore, the same precaution is 
required when addressing registers close to the limits of these register types.  

 

For more information about device registers and addressing, please consult the manufacturer’s documentation. 

 

Attention:  

 You can read bit values from %AI, %AQ and %R registers, but you cannot write bit values to these registers. 

 You must not configure a range of addresses greater than the maximum block size (data buffer length) 
supported by each device within the same worksheet. The maximum data buffer length for this driver is 64 
bytes per standard driver worksheet. 
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Executing the Driver  

By default, Studio will automatically execute your selected communication driver(s) during application runtime. 

However, you may verify your application’s runtime execution settings by checking the Project Status dialog. 

To verify that the the communication driver(s) will execute correctly: 

1. From the main menu bar, select Project → Status. The Project Status dialog displays: 

 

Project Status Dialog 

2. Verify that the Driver Runtime task is set to Automatic. 

 If the setting is correct, then proceed to step 3 below. 

 If the Driver Runtime task is set to Manual, then select the task and click the Startup button to toggle the 
task’s Startup mode to Automatic.  

3. Click OK to close the Project Status dialog.  

4. Start the application to run the driver. 
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Troubleshooting 

If the SRTP driver fails to communicate with the target device, then the database tag(s) that you configured for the 
Read Status or Write Status fields of the Main Driver Sheet will receive an error code. Use this error code and the 
following table to identify what kind of failure occurred. 

 

Error 
Code 

Description Possible Causes Procedure to Solve 

0 OK  Communication without problems None required. 

1 Failed to allocate memory Insufficient memory for driver buffers  Check the buffer configuration and try to reduce the buffer 

size. (See Configuring the Communication Parameters.) 

 Increase the computer or HMI memory. 

2 Error connecting Cannot establish a TCP/IP connection to 
the device 

 Check the device to be sure it is connected to the network. 

 Check the IP Address specified in the worksheet Station 

field to be sure it matches the device’s IP Address. 

3 Insufficient buffer Block Size is higher than RX Buffer or 
higher than TX Buffer. 

 Check  Block Size, RX Buffer and TX Buffer configuration, 

RX Buffer must be at least twice the Block Size value 

-34 Invalid Address Invalid Address provided in the worksheet 
Address field  

 If you used a tag in the Header field, verify that the tag 

value is valid for the configured addresses. 

 If you are not using tags, and you changed the Header 

after configuring the addresses, the addresses may be 

invalid for the new Header.  

-37 Invalid Header Invalid Header provided in the worksheet 
Header field 

Type a valid header into the Header field (see page Error! 
Bookmark not defined.  for configuration instructions). 

-38 Invalid Station Invalid Station provided in the worksheet 
Station field 

Type a valid station into the Station field (see page Error! 
Bookmark not defined.  for configuration instructions). 

-39 Invalid Block Size Offset specified in worksheet is too big and 
the message cannot be framed. 

Change the offsets or create a new worksheet. 

-15 Timeout waiting to start a 
message 

 Disconnected cables 

 PLC turned off, or in stop or error mode 

 Wrong station number 

 Wrong RTS/CTS configuration settings 

 Check the cable wiring. 

 Check the PLC state; it must be RUN. 

 Check the station number.  

 Check the configuration. See the Studio Technical 

Reference Manual for valid RTS/CTS settings. 

-17 Timeout between rx chars  PLC in stop or error mode 

 Wrong station number 

 Wrong parity 

 Wrong RTS/CTS configuration settings 

 Check the PLC state; it must be RUN. 

 Check the station number. 

 Check the configuration. 

 Check the configuration.  See the Studio Technical 

Reference Manual for valid RTS/CTS settings. 

 



SRTP – Driver Version 10.2 

Doc. Revision L – Jun 30th, 2009 

Page 15/17 

 

 Tip:  

You can monitor communication status by establishing an event log in Studio’s Output window (LogWin 

module). To establish a log for Field Read Commands, Field Write Commands and Serial Communication, right-click 

in the Output window and select the desired options from the pop-up menu. 

You can also use the LogWin module (Tools  LogWin) to establish an event log on a remote unit that runs 
Windows CE. The log is saved on the unit in the celog.txt file, which can be downloaded later. 

 

If you are unable to establish communication between Studio and the target device, then try instead to establish 
communication using the device’s own programming software (e.g., LogicMaster 90). Quite often, communication 
is interrupted by a hardware or cable problem or by a device configuration error. If you can successfully 
communicate using the programming software, then recheck the driver’s communication settings in Studio. 

To test communication between Studio and the device, we recommend using the sample application provided 
rather than your new application. 

If you must contact us for technical support, please have the following information available: 

 Operating System (type and version): To find this information, select Tools → System Information.  

 Project Information: To find this information, select Project → Status. 

 Driver Version and Communication Log: Displays in the Studio Output window when the driver is running. 

 Device Model and Boards: Consult the hardware manufacturer’s documentation for this information. 
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Sample Application 

A sample application that employs the SRTP driver is provided on the Studio installation CD. We strongly 
recommend that you use this sample application to test the driver before you develop your own applications, for 
the following reasons: 

 To better understand the information and instructions provided in this document; 

 To verify that your driver configuration is working satisfactorily with the target device; and 

 To ensure that the all of hardware used in the test (i.e. the device, adapter, cable, and PC) is functioning 
safely and correctly. 

 

Note:  

The following instructions assume that you are familiar with developing project applications in Studio. If you 

are not, then please review the relevant chapters of the Studio Technical Reference Manual before 

proceeding. 

 

To use the sample application: 

1. Configure the device’s communication settings according to the manufacturer’s documentation. 

2. Run Studio. 

3. From the main menu bar, select File  Open Project. 

4. Insert the Studio installation CD and browse it to find the sample application. It should be located in the 
directory \COMMUNICATION EXAMPLES\SRTP. 

5. Select and open the sample application. 

6. Configure and test the driver, as described in the rest of this document. 

When you have thoroughly tested the driver with your target device, you may proceed with developing your own 
Studio application projects. 

 

 Tip:  

You can use the sample application screen as the maintenance screen for your own applications.  
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